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Financial Planning & Analysis
Financial Planning & Analysis (FPA) helps organizations make better IT financial decisions by reducing
the effort involved with managing IT finance and giving business the financial transparency it demands.
FPA does this by consolidating and allocating planned and actual costs from HP Asset Manager and HP
 Project and Portfolio Management.

With pre-built data integration, data cleansing, and a central repository for cost information, FPA helps
organizations significantly reduce the effort involved in transforming cost and budget data into easy to
understand cost information. It provides information in ameaningful way to business, accounting, and IT
management stakeholders with pre-built reports and ad hoc analysis. Along the way, it supports financial
management process improvement by providing unprecedented visibility into process effectiveness and
efficiency.

Financial Planning & Analysis overview

Financial Planning & Analysis accelerates time to value by providing a complete business intelligence
platform. Financial Planning & Analysis extracts data from HP Asset Manager and HP Project and Port-
folio Management and consolidates it into a robust data warehouse. ITIL-based analytics and dashboards
show process and financial performance trends. Financial Planning & Analysis augments this platform
with an allocation engine for planned and actual costs, a rules engine to calculate monetary business
impact of incidents and changes, and an optimization engine to simulate changes to factors under IT’s
control.

Features

Financial Planning & Analysis, formerly called IT Analytics, is the successor to earlier versions of HP
 DecisionCenter. The complete Financial Planning & Analysis package contains different applications
that enablemanagement to perform advanced analyses using data extracted from HP applications. Finan-
cial Planning & Analysis uses an integrated version of SAP® BusinessObjects Enterprise XI to complete
the ETL processes and format out-of-box and ad hoc analytics. The following table summarizes Financial
Planning & Analysis features in this release.

Feature Description

Financial
Planning &
Analysis
(FPA)

Application that provides your IT stakeholders with action-
able cost information that supports effective cost con-
tainment and investment decisions. It includes IT cost
consolidation, IT cost allocation, allocation scenarios, IT
cost dashboard, Cost Explorer, analytics, and integration
with HP Asset Manager and HP Project and Portfolio Man-
agement.

Data Imports historical incident, project, and financial data into the data
 warehouse to populate scenarios and analytics.

Application
infrastructure

Applications run in a single framework with a single navigation pane that
accesses different components, out-of-box analytics, and SAP® Busi-
ness Objects Enterprise XI in an integrated environment.
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Financial Planning & Analysis architecture

The Financial Planning & Analysis internal components enable you to define data driven scenarios that
predict the result of business decisions. It depends on SAP® Business Objects, which is an enterprise
business intelligence solution that interacts directly with Financial Planning & Analysis to summarize data
in reports or display it in management dashboards.

SAP® BusinessObjects Data Services is the ETL tool that extracts data from Asset Manager or Project
and Portfolio Management to populate the data warehouse.
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What's new?
HP Financial Planning & Analysis, formerly known as IT Analytics, is an integrated part of the HP BTO
Operations version 9 portfolio. Using this version number aligns Financial Planning & Analysis with other
products releasing in the same time frame. Financial Planning & Analysis 9.10 is aminor release building
on IT Analytics 2.01. There are no underlying architectural changes to this version. Financial Planning &
Analysis contains new features and enhancements. Read the topics in this section to learnmore about:

l Allocation rules
l BTO Portfolio compatibility
l Dashboards
l Documentation
l Installation and configuration
l Menu bar
l Performance

Allocation rules

Costs can now be allocated to targets usingmetric based allocation. This type of allocation distributes
costs dynamically with values that might change from period to period. For example, an Organization's
head count, the amount of disk space that a Project consumes, or the number of service tickets logged by
a Person.

BTO portfolio compatibility

The Financial Planning & Analysis application relies on data from Asset Manager or Project and Portfolio
Management Financial Management (or both) to produce results. This version of Financial Planning &
Analysis adds compatibility with Project and Portfolio Management 9.10.

The HP Project and Portfolio Management Financial Management module generates data about budgets.
Extract, Transform, and Load (ETL) processes can extract this data, consolidate it with similar data from
other applications, and store it in the data warehouse. Project and Portfolio Management Financial Man-
agement typically produces capital and operating planned and actual cost data.

HP Asset Manager generates data about the physical, financial and contractual aspects of IT assets.
Extract, Transform, and Load (ETL) processes can extract this data, consolidate it with similar data from
other applications, and store it in the data warehouse. Asset Manager typically captures inventory and
configuration data about every device and the software installed on those devices.

For more information about the Business Technology Optimization (BTO) portfolio, see the HP web site:
Business Technology Optimization.

Dashboards

This version of Financial Planning & Analysis expands support with new dashboards that enable IT exec-
utives to view planned versus actual cost.

l Business Service dashboard
l Customer dashboard
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l Financial Summary dashboard
l IT Organization dashboard
l Program dashboard

Dashboards provide a view of the areas with the highest variance, helping IT executives to focus their
management attention on areas of potential concern.

Documentation

This version contains separate documentation for the application and the data warehouse. The guides are
available in PDF format for electronic viewing or printing with Adobe Reader®. If necessary, you can
obtain the latest version of Adobe Reader from the Adobe (http://www.adobe.com) web site. To obtain the
most current version of all Financial Planning & Analysis documentation, visit the product manuals web
site at: HP Software Product Manuals

This site requires that you register as an HP Passport user and sign in. To register for an HP Passport ID,
go to: HP Passport Registration.

Product Manual Description

HP Financial Planning & Analysis Application User Guide Is the complete set of Help system topics
organized into book format.

HP Financial Planning & Analysis DataWarehouse Administration
Guide

Contains information about how to configure
and use the HP data warehouse.

HP Financial Planning & Analysis ETL ReferenceGuide Describes the Extract, Transform, and Load
 (ETL) process and how it changes and con-
solidates data so that it can be used for report-
ing purposes.

HP Financial Planning & Analysis Installation and Configuration
Guide

Describes how to install and configure the
data warehouse and Financial Planning &
Analysis.

Installation and configuration

The data warehouse installation and configuration is a separate process that youmust complete before
you install and use Financial Planning & Analysis. The Configuration Tool assists you in completing the
installation.

This version of the Configuration Tool has additional capabilities:

l The Configuration Path dialog enables you to configure a new installation or upgrade an existing
instance.

l You can select an alternate data source if you do not have HP Asset Manager or Project and Portfolio
Management data.
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To take advantage of creating customized dashboards, youmust now install SAP® BusinessObjects
Xcelsius and the Antivia Xcelsius™Web Intelligence Integration Suite (XWIS) add-on.

For more information about installation and configuration, see the Financial Planning & Analysis Instal-
lation and Configuration Guide.

Menu bar

The new horizontal menu bar enables you to access Financial Planning & Analysis features and link
directly to online tools.

Feature Navigates to

Allocations Allocation Scenarios home page

Dashboards Out-of-box dashboards: Financial Summary, Business Service, Customer, IT Org, and
Program

Reports Out-of-box Multiple Dimensional Cost Comparison Analysis report and any customized
reports

Admin Administrative-related reports concerning the data warehouse, audit, and control

Tools BusinessObjects Information Portal and printing

Help Online help

Performance

This version of Financial Planning & Analysis provides improved performance for the Dashboards and
Cost Explorer.

16



17



Working With Financial Planning & Analysis
Financial Planning & Analysis (FPA) helps organizations make better IT financial decisions by reducing
the effort involved with managing IT finance and giving business the financial transparency it demands.
FPA does this by consolidating and allocating planned and actual costs from HP Asset Manager and HP
 Project and Portfolio Management to help IT manage those costs more effectively.

FPA has these benefits:

l It speeds analysis of cost drivers and variance to plan.
l It supports multi-dimensional analysis of planned and actual costs with a dedicated analytical interface
for IT Financial Analysts.

l It offers business-focused analytics that provide standard views of IT financial performance.

To start using FPA

First make sure that the application is installed and configured according to the directions in the Financial
Planning & Analysis Installation and Configuration Guide.

1. Log on to the application web server.
n Type the Financial Planning & Analysis URL in your browser. For example, type: http://server-
name:portnumber/FPA/

n Type a valid Username and Password.
n Click Log in.

2. From the main menu bar, click one of these links:
n Allocations
n Dashboards
n Reports

What is Financial Planning & Analysis?

Financial Planning & Analysis (FPA) provides cost visibility for IT. Capable of supporting numerous IT
cost dimensions, FPA provides the informational needs of IT management, accounting, and business
leaders to help themmake better investment and IT decisions and to look for trends in IT cost drivers and
budget variance.

FPA includes several ways to analyze the allocation results. For financial analysts, FPA offers a stream-
lined interface called Cost Explorer that helps the analyst answer ad hoc questions quickly. For business
users and IT management, FPA offers out-of-box analytics that show important financial data concerning
entities such as organizations and business services. FPA also offers a dashboard that helps users
quickly identify IT financial areas that require attention.

The Financial Planning & Analysis component has these features:

l IT cost consolidation: FPA allows your organization to consolidate planned and actual costs in a sin-
gle system. It gives IT the big picture as well as the detail it needs to more effectively manage budget
performance.

l IT cost allocation:With the FPA allocation engine, IT can distribute cost across multiple cost models
giving it the ability to analyze budget performance from many angles.

l Allocation scenarios: You can create multiple “what-if” allocation scenarios and use the results to com-
pare budget versions against actual costs and budget objectives.
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l IT cost dashboard: The FPA Dashboard lets your IT executives view planned versus actual per-
formance for IT overall, by customer, by IT organization, by service, by program, and by project. Your IT
executives may also see the areas with the highest variance to help them focus their management
attention.

l Cost explorer: The FPA Cost Explorer allows your IT finance and cost analysts to systematically
explore cost variance by organization, business service, application, program, project, cost center, and
cost category, as well as other dimensions. By slicing and filtering data across multiple dimensions,
analysts can gain new insight into what is driving costs, where the largest variance to plan is taking
place, and why the variance might be happening.

l IT cost analytics: Through Web Intelligence analytics, users can see daily updates on planned versus
actual performance. Users can modify the out-of-box analytics as necessary to support the specific cost
analysis needs of their organization. Users can also perform ad hoc analysis of cost data to answer
less common questions while knowing that the data they are seeing is consistent across all users.

l Integration with HP Asset Manager (AM) software and HP Project and Portfolio Management (PPM)
Center software: Out-of-box integrations with AM and PPM Center make gathering cost data more effi-
cient. Integration processes keep the data current.

Allocations

The allocation tool is a component of Financial Planning & Analysis (FPA) that enables you to create sce-
narios that transform cost and budget data into meaningful cost information. The scenarios use data gath-
ered from Asset Manager and Project and Portfolio Management.

Assumptions

In Financial Planning & Analysis (FPA), allocations are based on predefined assumptions and the busi-
ness rules of your organization. Actual and planned cost allocations include these common assumptions:

l The financial analyst needs access to the details related to the cost to properly understand the seman-
tics of the cost to be allocated. For example, if a cost is related to an asset, the analyst needs access to
the fields on that asset record to help determine the proper allocation. FPA provides most of the needed
information.

l Costs are not aggregated prior to allocation. Instead, costs are allocated at the lowest level of gran-
ularity possible, using aggregation later in the process.

l Allocation rules are not used to generate transactions.
l Costs are brought into the data warehouse in a local currency and an exchange rate converts the local
currency into a reference currency.

l Costs that span multiple dates should be broken down into smaller periods, at least monthly, prior to
allocation.

l The financial analyst allocates an actual cost for one of these reasons:
n To enrich the cost by adding a 1:1 relationship to the cost, resulting in a 100% allocation.

or

n To distribute the cost by splitting it across two or more relationships, resulting in a partial allo-
cation.

This table compares the assumption differences between actual cost allocation and planned cost allo-
cation.
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Actual Cost Allocation Planned Cost Allocation

All actual costs are related to a cost type/cat-
egory.

Planned costs may be related to a budget.

The financial analyst wants to perform bulk
allocations rather than allocate each cost
individually. The best way is to specify criteria
that are used to select a set of costs and to
establish what kind of allocation to apply to
that set of costs.

The financial analyst wants to perform
individual allocations rather than allocate
costs in bulk.

This release of FPA explicitly supports a cash
flow view of costs.

Planned costs represent aggregated esti-
mates of future costs and themain pur-
pose of the allocation is to break down
those aggregates to the same level the
actual costs are aggregated through
actual cost allocation.

Actual costs are associated with a single
date. Using this date, the cost is associated
with a financial period.

Planned costs are associated with a finan-
cial period.

Cost datamodel

The Financial Planning & Analysis cost datamodel is a star schema that consists of a Cost fact table
with related dimensions that include these relationships:

l Application
l Base Currency
l Budget
l Budget Line
l Business Service
l Config Item
l Contract
l Cost Category
l Cost Center
l Customer
l Date (Local)
l Date (UTC)
l Discretionary Flag
l Fiscal Period
l IT Functional
l Incurred Person
l Local Currency
l Location
l Opex/Capex Flag
l Organization
l Program

20



l Project
l Supplier

When defining an allocation stage, you can distribute costs across your business model by these rela-
tionships. Each dimension represents another business model or way tomanage the costs. This enriches
the data in the Cost table.

During the Extract, Transform, and Load (ETL) process, SAP® BusinessObjects Data Services (BODS)
gathers the data for some entities frommultiple source systems. BODS then consolidates the data into a
target datamodel before loading it into the target layer of the data warehouse.

For more information about target datamodels and ERDs, see Target datamodels.

For more information the ETL process, see the Financial Planning & Analysis ETL ReferenceGuide. The
most current version of this document is available on the product manuals web site at: HP Software Prod-
uct Manuals

This site requires that you register as an HP Passport user and sign in. To register for an HP Passport ID,
go to: HP Passport Registration.

Dashboards

The dashboards let you view actual versus planned performance for customers, IT organizations, busi-
ness services, and programs. To help focus management attention, you can also use dashboards to view
the customers, IT organizations, business services, programs, and cost categories that have the highest
positive variance.

Data extracted from Project and Portfolio Management and Asset Manager populates the dashboards.

FPA data

When you install the Financial Planning & Analysis component, it uses data extracted from one or more of
these applications:

l Asset Manager
l Project and Portfolio Management

The following diagram shows the data flows that FPA uses.
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The source data is regularly refreshed by data warehouse Extract, Transform, and Load (ETL) processes.

For more information about running ETL jobs and using data warehouse tools, see the Financial Planning
& Analysis DataWarehouse Administration Guide. For more information about FPA data flows, see the
Financial Planning & Analysis ETL ReferenceGuide. Themost current versions of these documents are
available on the product manuals web site at: HP Software Product Manuals

This site requires that you register as an HP Passport user and sign in. To register for an HP Passport ID,
go to: HP Passport Registration.

Prerequisites

Success depends onmeeting these prerequisites:

l The data warehouse is installed and accessible.
l Your source database is Asset Manager, Project and Portfolio Management, or your own proprietary
data.

l You understand the assumptions for actual cost allocation and planned cost allocation.
l You define cost allocations using the cost data model.

Reports

You can use the out-of-box Web Intelligence (WebI) reports to view daily updates on actual versus
planned performance. You canmodify the analytics as necessary to support the specific cost analysis
needs of your organization. You can also perform ad hoc analysis of cost data to answer less common
questions, while knowing that the data you view is consistent across all users.

Data extracted from Project and Portfolio Management and Asset Manager populates theMultiple Dimen-
sional Cost Comparison Analysis report.
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Formore information about usingWebI reports, see theSAP® BusinessObjects Enterprise InfoView
User's Guide available at the SAP Help Portal (http://help.sap.com) web site.

Security roles

A security role determines what you can do in Financial Planning & Analysis (FPA).

You need at least one of these roles to access FPA. If you havemultiple roles, the one with themost
access rights has priority.

Note: All roles have read-only access rights for Dashboards. The FPA_CE_CONFIG role has read-only
rights for Allocations.

Role Allocations Dashboards Reports Admin Common

FPA_ADMIN X X X X X

FPA_ANALYTIC X X X

FPA_CE_CONFIG X X X X

DW_ADMIN X X

Contact your data warehouse administrator to change your access level.
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Allocations
The allocation tool is a component of Financial Planning & Analysis (FPA) that enables you to create sce-
narios that transform cost and budget data into meaningful cost information. The scenarios use data gath-
ered from Asset Manager and Project and Portfolio Management.

To use allocations

1. From the main menu bar, click Allocations > Scenarios.
2. Select the scenario.

Cost allocation

Organizations need to know where they spendmoney and what areas are driving costs. Costs can be
viewed from different perspectives, such as by IT department or programs. Allocation enables organ-
izations to compare planned and actual costs by these perspectives to better manage the business.

Cost allocation enriches the information by relating costs to areas that aremeaningful to the business. It
distributes costs across the business model.

For example, a Financial Analyst wants to create views of planned vs. actual cost by IT department, Pro-
gram, and Application. These views are collected from asset management and project management data
source systems. The analyst can change the cost records by defining rules through a series of steps. To
manage the Allocation Rules, FPA groups rules into Allocation Stages. These stages transform the orig-
inal costs into an enriched set of costs.

l Within a defined stage, the analyst creates a rule statement to define cost allocation rules. The first part
of the rule statement, called source selection, involves defining the specific planned or actual cost to be
allocated.

l The next part of the rule statement, called the target selection, allocates the costs to a target area. The
analyst can allocate to single or multiple dimensions.

l After the planned and actual stages and rules are defined, the Cost Explorer tool becomes available.
Cost Explorer provides a multi-dimensional cost analysis where the analyst can drill down from sum-
mary views of planned and actual costs.
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Allocation provides a way to analyze the cost data from different perspectives. By collecting the right
information, organizations canmanage their costs better.

Metric based allocation

Costs can be allocated to targets equally, by a fixed percentage, or usingmetric based allocation.

Metric based allocation distributes costs dynamically with values that might change from period to period.
For example, an Organization's head count, the amount of disk space that a Project consumes, or the
number of service tickets logged by a Person.

Example

By usingmetric based allocation, a company can track the IT cost for maintaining an email Business Serv-
ice for an Organization over a specified period. The financial analyst considers these factors:

l Everyone in the company uses an email service.
l People are grouped into Organizations.
l Organizational headcounts vary from period to period.
l IT provides email as one of its Business Services to all Organizations in the company.
l IT tracks the cost for maintaining this email service for each fiscal period (month).
l IT wants to distribute costs for this Business Service across all organizations based on their headcount.

The analyst defines the allocation scenario and date range. A stage in the scenario targets the Organ-
ization. Within the stage, the analyst defines a rule to find all costs that are associated with the email serv-
ice and distribute the costs using themetric values of headcount.

Allocation engine

The allocation engine is a process that communicates with the Financial Planning & Analysis web appli-
cation. It provides status information about your allocations when youmake changes to stages or rules. It
selects costs, updates relationships, and splits costs across the datamodel.

By using allocation scenarios, stages, and rules, financial analysts can allocate the costs to compare
planned versus actual costs and use the results for proper cost and budget management.

1: Define allocation scenarios

An allocation scenario describes what planned and actual IT cost information you want to analyze. The
data comes from asset management and project management systems.

Scenarios contain allocation stages, such as cost centers or organizations, to help you enhance the cost
information. You can further enrich the data with allocation rules that create new records without changing
the original data. The sequence of the allocation stages and allocation rules determines how the allocation
engine calculates the data.

Allocation scenario

An allocation scenario is a tool that enables you to analyze planned costs and actual costs by cat-
egorizing them. You can use categorized costs to compare planned (budgeted) costs to the actual costs.
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As an organization collects cost information in asset management and project management systems,
those costs are related to areas that aremeaningful to the business, such as projects or organizations.
The relationships established in these systems are often insufficient to meet the needs of IT financial man-
agement processes.

Tomeet IT’s financial management needs, costs must usually be enhanced with more information. This
enhancement can be as simple as adding a relationship to the cost that does not currently exist, or it can
be as complex as relating a portion of the cost to more than one dimension (for example, splitting the cost
70% to one organization and 30% to another organization). The process of enhancing the cost is called
cost allocation.

Financial Planning & Analysis (FPA) uses amethod of allocating costs to create new records that reflect
changes that the organization would like tomake without altering the original cost records. FPA uses Allo-
cation Rules to select which cost records to change and to specify how the new cost records will look.

Often, the organization needs to change the cost records through a series of steps to reach the desired
level of detail. This series of steps could involve hundreds of rules. To help organizations manage their
Allocation Rules, FPA groups rules into Allocation Stages. These stages help the organization sys-
tematically transform the original costs into an enriched set of costs. The organization can use the result
of this process in its analysis of planned and actual costs.

The allocation process is a way of using a set of assumptions to transform the way costs are distributed
among business entities. Organizations can apply different sets of assumptions to the same set of costs,
creating different results. An organizationmay want to compare the assumptions or they may have dif-
ferent sets of assumptions to support different analysis purposes. To support these needs, FPA enables
users to create Allocation Scenarios. Each scenario encodes a set of assumptions and produces a set of
results that can be analyzed independently of other allocation results.

A well-developed Allocation Scenario includes assumptions for both planned costs and actual costs. By
relating both types of costs to the same lists of relationships, an organization can analyze performance to
budget and better understand cost drivers. FPA includes several ways to analyze the allocation results.
For financial analysts, FPA offers a streamlined interface called Cost Explorer that helps the analyst
answer ad hoc questions quickly. For business users and IT management, FPA offers out-of-box ana-
lytics that show important financial data concerning dimensions like organizations and business services.
FPA also offers a dashboard that helps users quickly identify IT financial areas that require attention.

How do I add an allocation scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Click New.
3. Type an allocation Scenario name.
4. Optional. Type a Description.
5. Optional. Select Default scenario. You can have only one default scenario, which is the basis for all

financial analytics.
6. Optional. Select Process new data to enable the allocation engine to recalculate the costs whenever

new data arrives.
7. Set bounds to limit the amount of data to consider for allocation.

a. Select a Start period from the drop-down list.
b. Select an End period from the drop-down list.

Note: You can set No end period as the selection. The allocation engine processes the
latest period in the data.
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8. Click Save to add new stages to the allocation scenario.
9. Click Save and Close to return to the complete list of allocation scenarios.

How do I copy an allocation scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario to be copied.
3. Click Copy.
4. Type a unique New scenario name.
5. Optional. Type a new scenario Description.
6. Click Copy to return to the detail page of the copied record.

How do I delete an allocation scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Select the check box for the allocation scenario to be deleted.
3. Click Delete.
4. Click OK to confirm the deletion.

How do I filter a list of allocation scenarios?

1. From the main menu bar, click Allocations > Scenarios.
2. Do one of the following actions:

n Type a filter value in the text box at the top of the Scenario name column.
n Type a partial filter value.

3. Click Filter.

Examples

l If you type scenario, Financial Planning & Analysis finds all allocation scenarios that contain the letters
scenario, such as AllocationScenario001, ScenarioX, or Newscenario. A wildcard character is
assumed before and after the filter value.

l If you type scenario*, Financial Planning & Analysis finds all allocation scenarios that begin with the
letters scenario, such as ScenarioX.

l If you type *scenario, Financial Planning & Analysis finds all allocation scenarios that end with the
letters scenario, such as Myscenario.

How do I update an allocation scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario to be updated.
3. Edit any field. You can also add, delete, and reorder stages in this scenario.
4. Click Save to update this scenario.
5. Click Save and Close to return to the complete list of allocation scenarios.

How do I view an allocation scenario?

1. From the main menu bar, click Allocations > Scenarios.
From this list, you can add, delete, or filter an allocation scenario.

2. To view the details for any allocation scenario, or copy an allocation scenario, click the allocation sce-
nario.
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How do I add an allocation stage to a scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario.
3. To add a planned cost or an actual cost stage:

a. On the Planned Cost Stages or Actual Cost Stages tab, click New.
b. Type an allocation Stage name.
c. Optional. Type a Description.
d. Choose the Target dimension from the drop-down list.
e. Optional. Select Pass remaining costs to the next stage to calculate all costs.

Note: Costs carry forward from stage to stage. If all costs are not allocated, the unallocated
costs are not included in the calculation.

f. Click Save to add allocation rules to the stage.
g. Click Save and Close to return to the allocation scenario detail page to view the list of cost

stages.

How do I delete an allocation stage from a scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario that has the stage to be deleted.
3. On the Planned Cost Stages or Actual Cost Stages tab, select the check box for the allocation stage

to be deleted.
4. Click Delete. This action deletes the cost stage, refreshes the stage list for this scenario, and causes

the allocation engine to recalculate.
5. Click OK to confirm the deletion.

2: Define allocation stages

An allocation stage distributes costs across your business model. It enriches the data in the Cost table by
adding relationships, or dimensions, with special criteria called allocation rules.

When addingmultiple stages to an allocation scenario, Financial Planning & Analysis calculates the infor-
mation incrementally. The second stage uses the result of the first stage to add relationships.

The goal is to implement rules that relate all costs to the chosen relationship. Complete coverage pro-
vides the richest analysis. If the rule set does not include all of the costs, the system provides amethod
to allocate the remaining costs.

Allocation stage

An allocation stage enables you to enrich cost information by distributing costs across your business
model. To allocate costs to a stage, you add allocation rules where you specify what criteria to include.
Each stage uses the results of the previous stage.

How do I add an allocation stage?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario.
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3. To add a planned cost or an actual cost stage:
a. On the Planned Cost Stages or Actual Cost Stages tab, click New.
b. Type an allocation Stage name.
c. Optional. Type a Description.
d. Choose the Target dimension from the drop-down list.
e. Optional. Select Pass remaining costs to the next stage to calculate all costs.

Note: Allocated costs always carry forward from stage to stage. If all costs are not allocated,
the unallocated costs from this stage are not included in the available cost pool for the next
stage's allocation. Selecting “pass remaining costs to the next stage” ensures that ALL costs
are carried forward to the next stage, regardless of whether they were re-allocated by an allo-
cation rule in this stage.

f. Click Save to add allocation rules to the stage.
g. Click Save and Close to return to the allocation scenario detail page to view the list of cost

stages.

How do I delete an allocation stage?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario that has the stage to be deleted.
3. On the Planned Cost Stages or Actual Cost Stages tab, select the check box for the allocation stage

to be deleted.
4. Click Delete. This action deletes the cost stage, refreshes the stage list for this scenario, and causes

the allocation engine to recalculate.
5. Click OK to confirm the deletion.

How do I reorder allocation stages in a scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario that has the stages to be reordered.
3. On the Planned Cost Stages or Actual Cost Stages tab, select the check boxes for the allocation

stages to be reordered.
4. Click Move Up or Move Down to change the order. This action refreshes the list sequence.

The allocation engine recalculates the cost based on the new order.

How do I update an allocation stage?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario that has the stage to be updated.
3. On the Planned Cost Stages or Actual Cost Stages tab, click the allocation stage to be updated.

a. Edit any field.
Note: You cannot change the Target dimension when it has rules. To change the Target
dimension, you must first delete all rules from the Allocation Stage detail page.

b. Click Save to add, delete, update, or reorder rules to this stage.
c. Click Save and Close to return to the Allocation Scenario detail page to view the list of

stages.
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How do I view a list of allocation stages?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario that has the allocation stages to be viewed. On the Actual Cost Stages

tab and the Planned Cost Stages tab, you can view the list and add, delete, update, or reorder allo-
cation stages.

3. To view the details for any allocation stage, or add a new rule to the stage, click the allocation stage.

How do I add an allocation rule to an allocation stage?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be added.
3. On the Planned Cost Stages tab or the Actual Cost Stages tab, click an existing allocation stage.
4. Above the Rule name column, click New.
5. Type an allocation Rule name.
6. Optional. Type a Description.

Note: You can add a rule as a placeholder in the stage without defining the allocation criteria imme-
diately. The scenario remains in Draft mode until all rules are defined.

7. Click Save to add Cost Source and Cost Target information.
8. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

How do I delete an allocation rule from an allocation stage?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be deleted.
3. On the Planned Cost Stages or Actual Cost Stages tab, click the stage with the rule to be deleted.
4. Select the check box for the allocation rule to be deleted.
5. Click Delete. This action deletes the rule from this stage.

The allocation engine recalculates the cost for the scenario.

3: Define allocation rules

Allocation rules enable you to create a link between planned and actual costs for the purpose of com-
parison. The allocation rule interface helps you build valid rules quickly and easily.

After creating a rule, the allocation engine calculates the results. A status bar indicates how much of the
costs are allocated. The goal is to implement rules that relate all costs to the chosen relationship.

Rules can transform the data. A bar chart displays the cost relationships before and after allocation. Light
green bars indicate that costs were assigned prior to allocation. Aqua bars indicate post-allocation costs.

Allocation rule

An allocation rule provides a way to create new records that reflect cost changes without altering the orig-
inal cost records. A rule describes which costs to retrieve and how to assign the costs, thus enriching the
cost information.

For example, you can define Rule1 to find all costs that have a relationship with a project. Any costs that
meet the criteria are assigned to the project. You can then define Rule2 to split the costs across a project.
The results of these rules help youmake better business decisions.
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How do I add an allocation rule?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be added.
3. On the Planned Cost Stages tab or the Actual Cost Stages tab, click an existing allocation stage.
4. Above the Rule name column, click New.
5. Type an allocation Rule name.
6. Optional. Type a Description.

Note: You can add a rule as a placeholder in the stage without defining the allocation criteria imme-
diately. The scenario remains in Draft mode until all rules are defined.

7. Click Save to add Cost Source and Cost Target information.
8. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

How do I add Cost Source and Cost Target criteria?

Youmust define and save the information from the Cost Source and Cost Target tabs to complete cre-
ating the rule.

The Cost Source tab enables you to create a rule representing a Boolean expression similar to aWhere
clause in a SQL statement. Using the drag-and-drop operation, you can determine what basic cost rec-
ords to consider for the allocation.

To add Cost Source criteria

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated allocation stage containing the rule to be defined.
3. On the Planned Cost Stages or Actual Cost Stages tab, click an existing allocation stage.
4. Click an existing rule.
5. On the Cost Source tab, drag a cost object from the Cost model tree menu and drop it in the Cost

selection criteria area. The expression is in Edit mode.
n Click the down arrow in the first field to change the source data table or column name.
n Click the down arrow in the second field to change the operator.
n If applicable, click the down arrow in the third field to select another value. If the dimension
has too many values, click the Search icon.

o Type a value in the text box.
o Click the Search icon.
o Select the items to include in the filter.
o Click Select.

6. Do one of the following actions:

n Click Save at the end of the expression to save it.
n Click Cancel at the end of the expression to remove it.
n Click Cancel at the top of the page to return to the list of rules for this stage without saving

any expressions.
7. Roll the cursor over any expression to view Edit and Remove icons.

n Click Edit at the end of the expression to make changes.
n Click Remove at the end of the expression to delete it.
n Click Cancel at the top of the page to return to the list of rules for this stage without saving

any expressions.
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8. Continue the drag-and-drop operation until the rule is complete. You can drag an object to one of four
drop zones:

n An empty work area.
n Within the grouping box that encloses expressions joined by conjunctions.
n Outside the grouping boxes.
n Onto an existing expression.

9. Click AND to change it to OR to group the expressions into a new group box. You can change OR to
AND by clicking it.

The Cost Target tab enables you to distribute costs to your target equally, by a fixed percentage, or using
metric allocation. The allocation options are Equally and By percentage.

To add Cost Target criteria

1. Click the Cost Target tab.
2. From the Allocate costs drop-down list, select the allocation type.

n Equally: Distributes amounts evenly. For example, you have Dept1 and Dept2. The allo-
cation engine allocates 50% of each cost row to Dept1 and 50% of each cost row to Dept2. If
you specify only one target, 100% of the costs are allocated to that target.

n By percentage: Distributes by entering the proportion for each value. For example, you
select 70% for Dept 1 and 30% for Dept 2. The allocation engine allocates 70% of each cost
row to Dept 1 and 30% of each cost row to Dept 2.

n Metric based - selected targets: Distributes costs by the dimension names selected from
the list of objects in the target dimension. You must then select a Metric Name from the drop-
down list. For example, you select the Organization dimension with Corporate Finance and
Corporate IT as the selected target values and Headcount as the metric name. In this case,
the allocation engine distributes costs based on the headcount of these two targets.

n Metric based - all targets: Distributes costs to all targets listed in the target dimension. The
target value list no longer appears on the page. You must then select a Metric Name from the
drop-down list. For example, you select all targets of the Organization dimension and Head-
count as the metric name, The allocation engine distributes costs based on the headcount to
every target in the Organization dimension.

3. If you selected metric based allocation, choose the Metric Name from the drop-down list. The metric
table of the selected dimension provides the list of metric names.

4. From the Target dimension column on the left, select the records that you want to add to the Target
value column on the right. You can select multiple records by holding the Ctrl key and selecting the
check boxes next to the records to add. The bottom of the column displays the total number of records
for the dimension. You can do the following actions:

n If there are 10 or fewer records, select the records to add to the target value and click the
right arrows.

n If there are more than 10 records, select the records to add on each page and click the right
arrows. To navigate to other pages, you can click the next arrow or type a page number at
the bottom of the column.

n Type a value in the textbox and click Filter to narrow the record search.
n To remove a target value, click the check box beside the record, then click the left arrows.

5. Click Save to save Cost Source and Cost Target information.
6. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

How do I delete an allocation rule?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be deleted.
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3. On the Planned Cost Stages or Actual Cost Stages tab, click the stage with the rule to be deleted.
4. Select the check box for the allocation rule to be deleted.
5. Click Delete. This action deletes the rule from this stage.

The allocation engine recalculates the cost for the scenario.

How do I reorder allocation rules in a stage?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the allocation rules to be reordered.
3. On the Planned Cost Stages or Actual Cost Stages tab, click the allocation stage with the allocation

rules to be reordered.
4. Select the rules to reorder.
5. Click Move Up or Move Down to change the order. This action refreshes the list sequence.

The allocation engine recalculates the cost based on the new order.

How do I update an allocation rule?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be updated.
3. On the Planned Cost Stages or Actual Cost Stages tab, click the stage with the rule to be updated.
4. Click the allocation rule to be updated.
5. Edit any field on the detail page, Cost Source tab, or Cost Target tab.
6. Click Save to save the changes.
7. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

The allocation engine recalculates the cost data when the cost source or cost target criteria aremodified.

How do I view an allocation rule?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated allocation stage that has the rule to be viewed.
3. Click the allocation stage that has the rule to be viewed.

From this list, you can add, delete, or reorder an allocation rule.
4. To view the details for any allocation rule, click the allocation rule.

4: View Cost Explorer

The Cost Explorer tool enables you to interactively view and filter allocation results in the form of charts
that show variance between planned and actual costs. With Cost Explorer, you can easily configure the
chart views, providing the IT organization new insight and better alignment with the business it supports.

Cost Explorer is accessible from an allocation scenario.

Cost Explorer

An analysis of costs is crucial to budgeting and planning. The Cost Explorer tool provides amulti-dimen-
sional cost analysis where you can easily change the analytic.

With Cost Explorer, you can do these tasks:
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l Define the dimensions and measures you want to view.
l Save multiple configurations of the same scenario.
l Sort the chart order.
l Filter on all dimensions.
l Email the configuration link to others.

Cost Explorer provides the ability to examine the results of allocated costs and view variance between
planned and actual costs.

Configuration

A Cost Explorer configuration contains settings that you can define to display chart views of your sce-
nario. You can definemultiple configurations for your scenario to provide different views. The default con-
figuration includes these settings:

l Fiscal month on the x-axis
l Plan and actual cost allocations
l Reference currency from the source data

You can easily change the chart views to provide additional analytics.

Measures

Cost Explorer enables you to compare cost measures that provide information about the variance
between planned and actual costs. Cost Explorer validates whichmeasures you can compare.

The analysis can include thesemeasures:

l Current sum of plan and actual, which is the latest displayed period in the chart.
l Cumulative sum of plan and actual, which contains the amount of all the displayed periods.
l Variance value, which compares the planned and actual costs.
l Percent variance of actual and cumulative values.

How do I add a configuration?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario with the configuration to be added.
3. Configure the settings.

a. On the Settings tab, choose a dimension from the Group by these dimensions (y-axis)
drop-down list. You can choose up to three unique dimensions.

b. Choose one dimension from the And (x-axis) drop-down list. The default is Fiscal Month .
c. Choose up to three measures from the Use these measures drop-down list. The default

measures are Plan and Actual.
d. To assign a different color to the measure, click the color icon next to the measure and select

a color.
e. Choose a view to Sort charts by from the drop-down list. This displays the charts in your

order of preference.
f. Choose the currency type from Filter costs by currency . The default is Show all costs (ref-
erence currency). You can choose a different currency from the Show cost subset drop-
down list.
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g. Choose a value from the Use this scale drop-down list. The currency scale can be thou-
sands or millions.

h. Choose a value from the Chart height drop-down list to change the size of the chart.
4. On the Filters tab, choose a dimension from the drop-down list and do one of the following steps:

a. Select the values from the drop-down list to display on the chart.

b. If the dimension has too many values to list, click the Search icon.
i. Type a value in the text box.
ii. Click Search.
iii. Select the items to include in the filter list.
iv. Click Select to add the items to the filter list.

5. Click Update Chart to view the configuration change results.
Note: You can click Update Chart at any time to view configuration changes.

6. Click Save as to save these settings as a new configuration.
a. Type the name.
b. Click OK.
c. Click OK to confirm the new configuration.

7. Optional. Click Email Link to send the configuration URL to another user. The recipient must have a
valid user name and password to access the configuration.

How do I delete a configuration?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario with the configuration to be deleted.
3. Select the configuration to be deleted in the Default Configuration drop-down list.
4. Click Delete.
5. Click OK to confirm the deletion.

How do I email a configuration link?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario with the configuration link to be sent.
3. Select a configuration in the Default Configuration drop-down list.
4. Click Email Link to send the configuration URL to another user. The recipient must have a valid user

name and password to access the configuration.

How do I update a configuration?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario to be updated.
3. Choose a configuration in the Default Configuration drop-down list.
4. Edit any field.
5. Click Update Chart to view the configuration change results.
6. Do one of the following actions:

a. Click Save to save the current settings for this configuration.
b. Click Save as to add these settings as a new configuration.

i. Type the name.
ii. Click OK.

7. Click OK to confirm.
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8. Optional. Click Email Link to send the configuration URL to another user. The recipient must have a
valid user name and password to access the configuration.

How do I view Cost Explorer?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario to be viewed. From this view you can add, delete,

save, or update a configuration. You can send the configuration URL to another user.
3. If you edit any field on the Settings or Filters tab, click Update Chart to view the configuration change

results.

How do I view another configuration of the scenario?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario with the configuration to be viewed.
3. Select a configuration in the Default Configuration drop-down list. From this view you can add, delete,

save, or update a configuration. You can send the configuration URL to another user.
4. If you edit any field on the Settings or Filters tab, click Update Chart to view the configuration change

results.

How do I update a view of cost measures?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario to be updated.
3. Choose a configuration in the Default Configuration drop-down list.
4. Choose up to three measures from the Use these measures drop-down list. The default measures are

Plan and Actual.
5. Click Update Chart to view the results.
6. Do one of the following actions:

a. Click Save to save the current settings for this configuration.
b. Click Save as to save these settings as a new configuration.

i. Type the name.
ii. Click OK.

7. Click OK to confirm.
8. Optional. Click Email Link to send the configuration URL to another user. The recipient must have a

valid user name and password to access the configuration.

How do I sort charts?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario with the charts to be sorted.
3. Choose a view to Sort charts by from the drop-down list. This displays the charts in your order of pref-

erence. You can sort charts by these parameters:
n Default. Alphabetical by the y-axis
n Cumulative actual, plan, or variance values
n Maximum actual, plan, variance, or % variance values

Note: If all charts have the same sorting score, the charts are sorted alphabetically.
4. Click Update Chart to view the sort results.
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5. Do one of the following actions:
a. Click Save to save the current settings for this configuration.
b. Click Save as to save these settings as a new configuration.

i. Type the name.
ii. Click OK.

6. Click OK to confirm.
7. Optional. Click Email Link to send the configuration URL to another user. The recipient must have a

valid user name and password to access the configuration.

How do I add a filter in Cost Explorer?

1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario with a filter to be added.
3. Choose a configuration in the Default Configuration drop-down list.
4. On the Filters tab, choose a dimension from the drop-down list.
5. Do one of the following actions:

a. Select the values from the drop-down list to display on the chart.

b. If the dimension has too many values to list, click the Search icon.
i. Type a partial value in the text box.
ii. Click Search.
iii. Click Select to add the items to the filter list.

6. Click Update Chart to view the results.
7. Do one of the following actions:

a. Click Save to save the current settings for this configuration.
b. Click Save as to save these settings as a new configuration.

i. Type the name.
ii. Click OK.

8. Click OK to confirm.
9. Optional. Click Email Link to send the configuration URL to another user. The recipient must have a

valid user name and password to access the configuration.

5: Publish results

By publishing results to the data warehouse after you create an allocation scenario, the rules become
available to the data warehouse for continuous processing. The Extract, Transform, and Load (ETL) proc-
ess loads data from the original cost table and creates new records in a separate environment.

A status box indicates the state of your request and what actions are available. For example, when the
state is Publication Requested, you can cancel the request.

Status Available Action

Publish Requested Cancel

Publish started {date/time} Unpublish

Published {date/time} Unpublish

Unpublish Requested Cancel
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Status Available Action

Unpublished started {date/time} Publish

When you first create the scenario, it is in unpublishedmode. You can continue to update the scenario in
this mode.

How do I publish results?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario to be published.
3. In the Publishing status box, click Publish. The publication start date and time appear in the Publishing

status box when the Extract, Load, and Transform (ETL) process begins.
Note: You cannot update the scenario during this process.

How do I unpublish results?

1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario to be unpublished.
3. In the Publishing status box, click Unpublish. The unpublication start date and time appear in the Pub-

lishing status box when the Extract, Load, and Transform (ETL) process begins.

38



Dashboards
The dashboards let you view actual versus planned performance for customers, IT organizations, busi-
ness services, and programs. To help focus management attention, you can also use dashboards to view
the customers, IT organizations, business services, programs, and cost categories that have the highest
positive variance.

Data extracted from Project and Portfolio Management and Asset Manager populates these dashboards:

l Business Service
l Customer
l Financial Summary
l IT Org
l Program

To use dashboards

l From the main menu bar, click Dashboards and select the dashboard.

Dashboards follow these standard rules:

l When sorting by name, the order is case sensitive. All upper case terms appear first. For example,
APAC precedes Administration.

l Pie charts display the top five items and add all remaining items to Others.
l The displayed values in pie charts are rounded to thousandths. Percentage calculations are based on
the raw values.

Financial Summary dashboard

The Financial Summary dashboard provides an organization’s CIO, IT Financial Manager, IT Financial
Analyst and IT Manager a view of how the organization is doing from the perspective of staying within its
defined financial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level view of
the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The third tier
shows a table that provides amore detailed view of the data.

Tier 1

The YTD Plan Vs. Actual chart enables you to view your total IT planned versus actual costs for the year-
to-date. The chart can help answer these business questions:

l Is the organization staying within the PoR?
l How much does the organization have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest actual
cost. The chart can help answer these business questions:

l Which top five suppliers are consuming the largest actual cost?
l What percent of the actual cost is for all other suppliers?

The YTD Discretionary table and pie chart enable you to view your total discretionary cost versus non-dis-
cretionary cost for a fiscal period. The chart can help answer these business questions:
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l Is the organization within its PoR for discretionary and non-discretionary expenses?
l What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Capex Vs. Opex table and pie chart enable you to view your total capital expenditures versus
operating expenses for a fiscal period. The chart can help answer these business questions:

l Is the organization within its PoR for capital (Capex) and operating (Opex) expenses?
l What percentage of spending is capital expenses versus operating expenses?
l Where is the organization spending the majority of its actual expenses–on capital or operating
expenses?

Example

The first chart identifies the planned and actual costs. The second chart displays the top five suppliers
with the highest actual cost. The third chart lists the total discretionary cost versus non-discretionary cost
for a defined fiscal period. The last chart lists the total capital expenses versus operating expenses for a
defined fiscal period.

The table below provides a description of the numbered items.

Item Description

1 TheYTD Plan Vs. Actual chart numerically displays the planned costs, actual costs, and the dif-
ference between them. The progress bar shows a negative difference between the planned and actual
costs in yellow. A vertical scale lists the percentage of planned versus actual.

Actual costs within 100% of the plan are green.
Actual costs between 100 – 110% are yellow.
Actual costs over 110% are red.

a The vertical progress bar shows the actual cost.

b The costs for plan, actual, and available (difference between the two) are
listed in thousands.
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Item Description

c The percent indicates
the actual cost divided
by the plan cost mul-
tiplied by 100.

2 TheYTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual cost
year-to-date.

a The legend identifies the suppliers.

b By placing themouse pointer over the pie chart, you can view the cost and
percent of total spending. The "Other" label in the pie chart displays the per-
centage of actual costs for all other remaining suppliers.

3 TheYTD Discretionary table and pie chart list your total discretionary and non-discretionary costs
for the year-to-date.

a The table lists the actual and plan costs for discretionary and non-dis-
cretionary spending.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

b By placing themouse pointer over the pie chart, you can view the per-
centage of actual discretionary versus non-discretionary costs for the year-
to-date.

4 TheYTD Capex Vs. Opex table and pie chart list your total capital and operating expenses for the
year-to-date.

a The table lists the actual and plan costs for capital and operating
expenses.

Actual costs within 100% of the plan are green.
Actual costs between 100 – 110% are yellow.
Actual costs over 110% are red.

b By placing themouse pointer over the pie chart, you can view the allo-
cation of the actual cost by capital versus operating expenses and identify
where the highest actual costs occur.

Tier 2

The data in this tier enables you to view themonthly, quarterly, and yearly planned costs. This tier con-
trols what data is displayed in Tier 3.
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The Plan Vs. Actual chart initially displays the cost in months, starting with the first month of the fiscal
year. You have the option to display the information quarterly. The chart can help answer these business
questions:

l How well is the organization staying within the plan on a monthly and quarterly basis?
l When did actual spending exceed the plan?

The Year-Over-Year Actual/Plan% chart provides historical monthly and quarterly data for the current
year and two previous years. The chart can help answer this business question:

l How well is the organization staying within the PoR based on historical spending of the PoR?

Example

The first chart in this tier shows themonthly and quarterly plan. The second chart provides historical
spending based on the current year and previous two years.

The table below provides a description of the numbered items.

Item Description
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1 ThePlan vs Actual chart displays monthly or quarterly planned and actual costs for a fiscal year. The
vertical bar indicates what was planned and the blue diamond indicates what was spent. You can select
the vertical bar to display the region details for that month or quarter in Tier 3. The selected bar is named
in the chart's subtitle. In this example, the current period is FY2009/03. It is darker than the other vertical
bars. You can select the View by Month option to switch the display betweenmonths and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost amounts
for other periods, the chart may not display a gray bar for the period or periods with the lower planned cost
amounts.

a The highest amount on the vertical axis represents themaximum amount
planned or spent for amonth or quarter within the current year.

b The legend identifies the costs:

Planned amount: Square
Actual amount spent: Diamond

2 TheYear-Over-Year Actual/Plan % chart provides details on what percent was actually spent com-
pared to what was planned over the last three years. The percentage is the amount spent divided by the
amount planned times 100. For example, if 120 was spent and 100 was planned, the percentage dis-
played will be 120%. Note that no icon will appear on the chart if data does not exist for that period.

a The highest amount on the vertical axis represents themaximum percentage
of the plan used for amonth or quarter period within the current year and pre-
vious two years.

b The legend identifies the year of themonth or quarter:

Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The table in this tier dynamically changes based on the time period selected in the Plan Vs. Actual chart
from Tier 2. The information can help answer these business questions:

l Which regions are exceeding the plan?
l Which regions have historically exceeded their plans?

Example

This example shows the details by region for themonth or quarter selected in the Plan Vs. Actual chart
from Tier 2. The table lists the actual and plan costs.

The table below provides a description of the numbered items.
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Item Description

1 The default table displays actual and plan costs for each region for the current month.

a The table shows the top eight regions for the current fiscal year. TheOthers
column lists the combined cost for all of the remaining regions. The table col-
umns display the selectedmonth’s or quarter's actual and plan costs for each
region. Fewer than eight regions may appear in the table if there are less than
eight regions in total or if one or more of the top eight regions does not have
costs for that month.

b The table displays actual and plan costs for each region, with totals for the
selectedmonth or quarter. Current and previous year values are shownwith
available data. The total valuemay be slightly different from a sum of the
actual and plan costs since each cell is rounded individually from the original
costs.

Actual costs within 100% of the plan are green.
Actual costs between 100 – 110% are yellow.
Actual costs over 110% are red.

Tier Interaction

The interactive dashboard dynamically updates the charts when you choose the option to view monthly or
quarterly costs or drill down to get more details.

The table below provides a description of the numbered items.

Item Description

1 By selecting the View by Month or View by Quarter option, Tier 2 and Tier 3 charts will be updated.
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2 By drilling down from this bar chart, themonthly or quarterly data will be updated in the Tier 3 table.

Business Service dashboard

The Business Service dashboard provides an organization’s CIO, IT Financial Manager, IT Financial
Analyst and IT Manager a view of how business services are doing from the perspective of staying within
their defined financial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level view of
the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The third tier
shows tables that provide amore detailed view of the data.

Tier 1

The information on this tier displays a high-level view of the data. The selection list in the first component
displays up to the top 100 IT business services. These services can be sorted alphabetically by name, or
sorted from highest to lowest by budget amount or by variance amount. Themetrics in the charts of this
tier are based on the business service that is selected from the first component.

The YTD Plan Vs. Actual chart enables you to view your total IT planned costs versus actual costs for the
year-to-date. The chart can help answer these business questions:

l Is the business service staying within the PoR?
l How much spending does the business service have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest actual
cost. The chart can help answer these business questions:

l What suppliers are consuming the majority of the actual cost?
l What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-dis-
cretionary cost for the year-to-date. The chart can help answer this business question:

l What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart can help
answer these business questions:

l What is the allocation of the actual cost by category?
l Which categories account for the majority of the business service's actual cost?
l What percent of the actual cost is for all other cost categories?

Example

This example shows the top 100 IT business services sorted by the highest planned cost. The first chart
identifies the planned and actual costs. The second chart displays the top five suppliers with the highest
actual cost. The third chart lists the total discretionary cost versus non-discretionary cost for a defined
period. The last chart identifies the cost by category.
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The table below provides a description of the numbered items.

Item Description

1 The drop-down option sorts up to the top 100 IT business services with the highest planned costs.

a The colors preceding the business service identify the state of the plan:

Green indicates that the actual cost is within 100% of plan.
Yellow indicates that the actual cost is between 100 - 110% of plan.
Red indicates that the actual cost is over 110% of plan.

b Business services are sorted by the highest planned costs. The drop-down
option determines the order of the list. The default is Business Service by
Plan.

Business Service by Plan lists the business services by the highest
planned costs.
Business Service by Variance lists the business services by those that are
most over-budget.
Business Service by Name lists the business services alphabetically.
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Item Description

2 TheYTD Plan Vs. Actual chart numerically displays the planned costs, actual costs,and the dif-
ference between them. The progress bar shows a negative difference between the planned and actual
costs in yellow. A vertical scale lists the percentage of planned versus actual.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a The vertical progress bar shows the actual cost.

b The costs for plan, actual, and available (difference between the two) are
listed in thousands.

c The percent indicates the actual cost divided by the plan cost multiplied by
100.

3 TheYTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual cost
year-to-date. In the example, this data does not exist; therefore, the chart is blank.

4 TheYTD Discretionary pie chart lists your total discretionary and non-discretionary costs for the
year-to-date.

a The legend identifies which section of the pie chart shows discretionary spend-
ing and which section shows non-discretionary spending.

b By placing themouse pointer over the pie chart, you can view the percentage
of discretionary costs and non-discretionary costs for the year-to-date.

5 TheYTD Actual Cost by Cost Category pie chart displays the actual costs by cost category in thou-
sands.

a The legend identifies the cost category.

b By placing themouse pointer over the pie chart, you can view the allocation of
the actual cost by category and identify themajority of the actual costs. The
"Other" label in the pie chart displays the percentage of actual costs for all
other cost categories.

Tier 2

The data in this tier enables you to view themonthly, quarterly, and yearly planned costs of the business
service you selected in Tier 1.

TheMonthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month of the
fiscal year. You have the option to display the information quarterly. The chart can help answer these busi-
ness questions:

l How well is the business service staying within the plan on a monthly and quarterly basis?
l When did actual spending exceed the plan?
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The Year-Over-Year Actual/Plan% chart provides historical monthly and quarterly data for the current
year and two previous years. The chart can help answer this business question:

l How well is the business service staying within the budget based on historical spending of the budget?

Example

This example has two charts that interact with Tier 1. The first chart shows themonthly and quarterly
plan. The second chart provides historical spending based on the current year and previous two years.

The table below provides a description of the numbered items.

Item Description

1 ThePlan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal year. The
vertical bar indicates what was planned and the blue diamond indicates what was spent. You can
select the vertical bar to display the Programs, Organization, Supplier, and Cost Category details for
that month or quarter in Tier 3. The selected bar is named in the chart's subtitle. In the previous exam-
ple, the selected bar is FY2009/12. It is darker than the other vertical bars. You can select the View by
Month option to switch the display betweenmonths and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost amounts
for other periods, the chart may not display a gray bar for the period or periods with the lower planned
cost amounts.

a The highest amount on the vertical axis represents themaximum amount
planned or spent for amonth or quarter within the current year.

b The legend identifies the costs:

Planned amount: Square
Actual amount spent: Diamond
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Item Description

2 TheYear-Over-Year Actual/Plan % chart provides details on what percent was actually spent com-
pared to what was planned over the last three years. The percentage is the amount spent divided by
the amount planned times 100. For example, if 120 was spent and 100 was planned, the percentage dis-
played will be 120%. Note that no icon will appear on the chart if data does not exist for that period.

a The highest amount on the vertical axis represents themaximum per-
centage of the budget used for amonth or quarter period within the current
year and previous two years.

b The legend identifies the year of themonth or quarter:

Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected IT business service for
Programs, Organization, Supplier, and Cost Category. The information can help answer these business
questions:

l Where is the IT business service spending?
l Where does actual cost exceed the plan?
l What is the state of this IT business service's programs, organization, supplier, and cost category?

Example

This example shows the details for themonth or quarter selected in the Plan Vs. Actual chart from Tier 2.
The chart displays actual and plan costs for the cost category in January 2009. The table lists the actual
and plan costs.

The table below provides a description of the numbered items.
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Item Description

1 The bar chart displays actual and plan costs for the selected service in four areas: Programs, Organ-
ization, Supplier, and Cost Category. Each area is a separate tab.

a The horizontal bars display the actual and plan costs for the selected Programs,
Organization, Supplier, or Cost Category.

b The legend identifies the costs:

Actual costs: Blue
Plan costs: Gold

2 Using data from the selected Programs, Organization, Supplier, or Cost Category tab, the table
shows the details of plan versus actual for the selected business service area.

a The table lists the programs, organization, supplier, or cost category. An icon to
the left of each name indicates how well the business service area is staying
within the PoR.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

Note: Xcelsius does not display an alert icon when the planned cost for a pro-
gram, business service, supplier, or cost category is zero.

b The table shows the actual and plan costs of programs, organization, supplier,
or cost category. By clicking any column header, you can sort by ascending or
descending order.

Tier Interaction

The interactive dashboard dynamically updates the charts when you choose a business service, change
the option to view monthly or quarterly costs, drill down to get more details, or select a Programs, Organ-
ization, Supplier, or Cost Category tab.
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The table below provides a description of the numbered items.

Item Description

1 The drop-down option enables you to sort IT business services.

2 By selecting an IT business service from this list, all charts in Tier 1, Tier 2, and Tier 3 will change.

3 By selecting the View by Month or View by Quarter option, all charts in Tier 2 and Tier 3 will change.

4 By selecting this bar chart, Tier 3 charts will change.

5 By selecting the Programs, Organization, Supplier, or Cost Category tab, the chart and table in Tier 3 will
change.

Customer dashboard

The Customer dashboard provides an organization’s CIO, IT Financial Manager, IT Financial Analyst and
IT Manager a view of how customers are doing from the perspective of staying within their defined finan-
cial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level view of
the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The third tier
shows tables that provide amore detailed view of the data.

Tier 1

The selection list in the first component displays the top 100 customers. These customers can be sorted
alphabetically by name, or sorted from highest to lowest by plan amount or by variance amount. Themet-
rics in the charts of this tier are based on the customer that is selected from the first component.
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The YTD Plan Vs. Actual chart enables you to view a customer's total IT planned costs versus actual
costs for the year-to-date. The chart can help answer these business questions:

l Is the customer staying within the PoR?
l How much does the customer have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest actual
cost. The chart can help answer these business questions:

l Which top five suppliers are consuming the largest actual cost?
l What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-dis-
cretionary cost for the year-to-date. The chart can help answer this business question:

l What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart can help
answer these business questions:

l What is the allocation of the actual cost by category?
l Which top five categories account for the largest actual cost?
l What percent of the actual cost is for all other cost categories?

Example

This example shows the top 100 customers that have the highest planned cost. The first chart identifies
the planned and actual costs. The second chart displays the top five suppliers with the highest actual
cost. The third chart lists the total discretionary cost versus non-discretionary cost for a defined period.
The last chart identifies the cost by category.

The table below provides a description of the numbered items.

52



Item Description

1 This filter sorts the top 100 customers with the highest planned costs.

a Customers are sorted by the highest planned costs. The colors preceding the
customer identify the state of the plan:

Green indicates that the actual cost is within 100% of plan.
Yellow indicates that the actual cost is between 100 - 110% of plan.
Red indicates that the actual cost is over 110% of plan.

b The drop-down option determines the order of the list. The default is to sort
Customer by Plan.

Customer by Plan lists the customers by the highest planned costs.
Customer by Variance lists the customers by those that aremost over-plan
within the top 100.
Customer by Name lists the customers alphabetically.

2 TheYTD Plan Vs. Actual chart numerically displays the planned costs, actual costs, and the dif-
ference between them. The progress bar shows a negative difference between the planned and actual
costs in red. A vertical scale lists the percentage of planned versus actual.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a The vertical progress bar shows the actual cost.
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Item Description

b The costs for plan,
actual, and available
(difference between
the two) are listed in
thousands.

c The percent indi-
cates the actual
cost divided by the
plan cost multiplied
by 100.

3 TheYTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual cost
year-to-date.

a The legend identifies the suppliers.

b By placing themouse pointer over the pie chart, you can view the cost and per-
cent of total spending. The "Other" label in the pie chart displays the per-
centage of actual costs for all other suppliers who are not in the top five.

4 TheYTD Discretionary pie chart lists your total discretionary and non-discretionary costs for the
year-to-date.

a The legend identifies which section of the pie chart shows discretionary spend-
ing and which part shows non-discretionary spending.

b By placing themouse pointer over the pie chart, you can view the percentage
of discretionary costs and non-discretionary costs for the year-to-date.

5 TheYTD Actual Cost by Category pie chart displays the actual costs by cost category in thou-
sands.

a The legend identifies the cost category.

b By placing themouse pointer over the pie chart, you can view the allocation of
the actual cost by category and identify where the highest actual costs occur.
The "Other" label in the pie chart displays the percentage of actual costs for all
other cost categories.

Tier 2

The data in this tier enables you to view themonthly, quarterly, and yearly planned costs of the customer
you selected in Tier 1.

TheMonthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month of the
fiscal year. You have the option to display the information quarterly. The chart can help answer these busi-
ness questions:

54



l How well is the customer staying within the plan on a monthly and quarterly basis?
l When did actual spending exceed the plan?

The Year-Over-Year Actual/Plan% chart provides historical monthly and quarterly data for the current
year and two previous years. The chart can help answer this business question:

l How well is the customer staying within the plan based on historical spending of the plan?

Example

This example has two charts that interact with Tier 1. The first chart shows themonthly and quarterly
plan. The second chart provides historical spending based on the current year and previous two years.

The table below provides a description of the numbered items.

Item Description

1 ThePlan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal year. The
vertical bar indicates what was planned and the blue diamond indicates what was spent. You can
select the vertical bar to drill down into the programs, business service, supplier, or cost category
details for that month or quarter in Tier 3. The selected bar is named in the chart's subtitle. In the pre-
vious example, the selected bar is FY2009/03. It is darker than the other vertical bars. You can select
the View by Month or View by Quarter option to switch the display betweenmonths and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost amounts
for other periods, the chart may not display a gray bar for the period or periods with the lower planned
cost amounts.

a The highest amount on the vertical axis represents themaximum amount
planned or spent for amonth or quarter within the current year.
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Item Description

b The legend identifies the
costs:

Planned amount: Square
Actual amount spent:
 Diamond

2 TheYear-Over-Year Actual/Plan % provides details on what percent was actually spent compared to
what was planned over the last three years. The percentage is the amount spent divided by the amount
planned times 100. For example, if 120 was spent and 100 was planned, the percentage displayed will
be 120%. Note that no icon will appear on the chart if data does not exist for that period.

a The highest amount on the vertical axis represents themaximum per-
centage of the plan used for amonth or quarter period within the current
year and previous two years.

b The legend identifies the year of themonth or quarter:

Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected customer for Programs,
Business Service, Supplier, and Cost Category. The information can help answer these business ques-
tions:

l Where is the customer spending?
l Where does actual cost exceed the plan?
l What is the state of this customer's programs, business services, suppliers, and cost categories?

Example

This example shows the details for themonth or quarter selected in the Plan Vs. Actual chart from Tier 2.
The same information is displayed in a bar chart and in a table. The chart displays actual and plan costs
for an Unknown cost category in January. The table lists the actual and plan costs.
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The table below provides a description of the numbered items.

Item Description

1 The bar chart displays actual and plan costs for the selected customer in four areas: Program, Busi-
ness Service, Supplier, and Cost Category. Each area is a separate tab.

a The horizontal bars display the actual and plan costs for the selected Pro-
grams, Business Service, Supplier, or Cost Category.

b The legend identifies the costs:

Actual costs: Blue
Plan costs: Gold

2 Using data from the selected Programs, Business Service, Supplier, or Cost Category, the table
shows the details of plan versus actual for the selected customer.

a The legend identifies the plan costs and the difference between actual and
plan.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

Note: Xcelsius does not display an alert icon when the planned cost for a
program, business service, supplier, or cost category is zero.

b The table lists the actual and plan costs for the selected programs, busi-
ness service, supplier, or cost category.
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Tier Interaction

The interactive dashboard dynamically updates the charts when you choose a customer, change the
option to view monthly or quarterly costs, drill down to get more details, or select a Programs, Business
Service, Supplier, or Cost Category tab.

The table below provides a description of the numbered items.

Item Description

1 The drop-down option enables you to display all or a subset of customers.

2 By selecting a customer from this list, all charts in Tier 1, Tier 2, and Tier 3 will change.

3 By selecting the View by Month or View by Quarter option, all charts in Tier 2 and Tier 3 will change.

4 By drilling down from this bar chart, Tier 3 charts will change.

5 By selecting the Programs, Business Service, Supplier, or Cost Category tab, the charts in Tier 3 will
change.

IT Org dashboard

The IT Org dashboard provides an organization’s CIO, IT Financial Manager, IT Financial Analyst and IT
Manager a view of how organizations are doing from the perspective of staying within their defined finan-
cial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level view of
the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The third tier
shows tables that provide amore detailed view of the data.
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Tier 1

The selection list in the first component displays the top 100 organizations. These organizations can be
sorted alphabetically by name, or sorted from highest to lowest by plan amount or by variance amount.
Themetrics in the charts of this tier are based on the organization that is selected from the first com-
ponent.

The YTD Plan Vs. Actual chart enables you to view your total IT planned costs versus actual costs for the
year-to-date. The chart can help answer these business questions:

l Is the organization staying within the PoR?
l How much does the organization have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest actual
cost. The chart can help answer these business questions:

l Which top five suppliers are consuming the largest actual cost?
l What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-dis-
cretionary cost for the year-to-date. The chart can help answer this business question:

l What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart can help
answer these business questions:

l What is the allocation of the actual cost by category?
l Which top five categories account for the largest actual cost?
l What percent of the actual cost is for all other cost categories?

Example

This example shows the top 100 IT organizations that have the highest planned cost. The first chart iden-
tifies the planned and actual costs. The second chart displays the top five suppliers with the highest
actual cost. The third chart lists the total discretionary cost versus non-discretionary cost for a defined
period. The last chart identifies the cost by category.

The table below provides a description of the numbered items.
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Item Description

1 This filter sorts the top 100 IT organizations with the highest planned costs.

a Organizations are sorted by the highest planned costs. The colors preceding the
organization identify the state of the plan:

Green indicates that the actual cost is within 100% of plan.
Yellow indicates that the actual cost is between 100 - 110% of plan.
Red indicates that the actual cost is over 110% of plan.

b The drop-down option determines the order of the list. The default is Organ-
ization by Plan.

Organization by Plan lists the organizations by the highest budgeted costs.
Organization by Variance lists the organizations by those that aremost over-
budget.
Organization by Name lists the organizations alphabetically.

2 TheYTD Plan Vs. Actual chart numerically displays the planned costs, actual costs, and the dif-
ference between them. The progress bar is empty because there is no data for actual costs. A vertical
scale lists the percentage of planned versus actual.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a The vertical progress bar shows the actual cost.
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Item Description

b The costs for plan,
actual, and avail-
able (difference
between the two)
are listed in thou-
sands.

c The percent indi-
cates the actual
cost divided by the
plan cost multiplied
by 100.

3 TheYTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual cost
year-to-date.

a The legend identifies the suppliers.

b By placing themouse pointer over the pie chart, you can view the cost and per-
cent of total spending. The "Other" label in the pie chart displays the percentage
of actual costs for all other suppliers not in the top five.

4 TheYTD Discretionary pie chart lists your total discretionary and non-discretionary costs for the
year-to-date.

a The legend identifies which section of the pie chart shows discretionary spend-
ing and which section shows non-discretionary spending.

b By placing themouse pointer over the pie chart, you can view the percentage of
discretionary costs and non-discretionary costs for the year-to-date.

5 TheYTD Actual Cost by Category pie chart displays the actual costs by cost category in thou-
sands.

a The legend identifies the cost category.

b By placing themouse pointer over the pie chart, you can view the allocation of
the actual cost by category and identify where the highest actual costs occur.
The "Other" label in the pie chart displays the percentage of actual costs for all
other cost categories.

Tier 2

The data in this tier enables you to view themonthly, quarterly, and yearly planned costs of the IT organ-
ization you selected in Tier 1.

TheMonthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month of the
fiscal year. You have the option to display the information quarterly. The chart can help answer these busi-
ness questions:
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l How well is the IT organization staying within the plan on a monthly and quarterly basis?
l When did actual spending exceed the plan?

The Year-Over-Year Actual/Plan% chart provides historical monthly and quarterly data for the current
year and two previous years. The chart can help answer this business question:

l How well is the organization staying within the budget based on historical spending of the plan?

Example

This example has two charts that interact with Tier 1. The first chart shows themonthly and quarterly
plan. The second chart provides historical spending based on the current year and previous two years.

The table below provides a description of the numbered items.

Item Description

1 ThePlan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal year. The
vertical bar indicates what was planned and the blue diamond indicates what was spent. This example
has no data for actual costs, so the diamond does not appear. You can select the vertical bar to drill
down into the programs, business service, supplier, or cost category details for that month or quarter in
Tier 3. The selected bar is named in the chart's subtitle. In this example, the selected bar is
FY2009/12. It is darker than the other vertical bars. You can select the View by Month or View by
Quarter option to switch the display betweenmonths and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost amounts
for other periods, the chart may not display a gray bar for the period or periods with the lower planned
cost amounts.

a The highest amount on the vertical axis represents themaximum amount
planned or spent for amonth or quarter within the current year.
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Item Description

b The legend identifies the
costs:

Planned amount: Square
Actual amount spent:
 Diamond

2 TheYear-Over-Year Actual/Plan % chart provides details on what percent was actually spent com-
pared to what was planned over the last three years. The percentage is the amount spent divided by
the amount planned times 100. For example, if 120 was spent and 100 was planned, the percentage dis-
played will be 120%. Note that no icon will appear on the chart if data does not exist for that period.

a The highest amount on the vertical axis represents themaximum per-
centage of the plan used for amonth or quarter period within the current
year and previous two years.

b The legend identifies the year of themonth or quarter:

Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected IT organization for Pro-
grams, Business Service, Supplier, and Cost Category. The information can help answer these business
questions:

l Where is the IT organization spending?
l Where does actual cost exceed the plan?
l What is the state of this IT organization's programs, business services, suppliers, and cost categories?

Example

This example shows the details for themonth or quarter selected in the Plan Vs. Actual chart from Tier 2.
The same information is displayed in a bar chart and in a table.The chart displays actual and plan costs for
programs in January 2009. The table lists the actual and plan costs.
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The table below provides a description of the numbered items.

Item Description

1 The bar chart displays actual and plan costs for the selected IT organization in four areas: Programs,
Business Service, Supplier, and Cost Category. Each area is a separate tab.

a The horizontal bars display the actual and plan costs for the selected Programs,
Business Service, Supplier, or Cost Category. This example has no data for
actual costs, so the blue horizontal bar does not appear.

b The legend identifies the costs:

Actual costs: Blue
Plan costs: Gold

2 Using data from the selected Programs, Business Service, Supplier, or Cost Category, the table
shows the details of plan versus actual for the selected IT organization.

a The legend identifies the plan costs and the difference between actual and plan.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

Note: Xcelsius does not display an alert icon when the planned cost for a pro-
gram, business service, supplier, or cost category is zero.

b The table lists actual and plan costs for programs, business services, suppliers,
or cost categories.
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Tier Interaction

The interactive dashboard dynamically updates the charts when you choose an IT organization, change
the option to view monthly or quarterly costs, drill down to get more details, or select the Programs, Busi-
ness Service, Supplier, or Cost Category tab.

The table below provides a description of the numbered items.

Item Description

1 The drop-down option enables you to display all or a subset of IT organizations.

2 By selecting an IT organization from this list, all charts in Tier 1, Tier 2, and Tier 3 will change.

3 By selecting the View by Month or View by Quarter option, all charts in Tier 2 and Tier 3 will change.

4 By drilling down from this bar chart, Tier 3 charts will change.

5 By selecting the Programs, Business Service, Supplier, or Cost Category tab, the charts in Tier 3 will
change.

Program dashboard

The Program dashboard provides an organization’s CIO, IT Financial Manager, IT Financial Analyst and
IT Manager a view of how programs are doing from the perspective of staying within their defined financial
Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level view of
the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The third tier
shows tables that provide amore detailed view of the data.
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Tier 1

The selecton list in the first component displays the top 100 programs. These programs can be sorted
alphabetically by name, or sorted from highest to lowest by plan amount or by variance amount. Themet-
rics in the charts of this tier are based on the program that is selected from the first component.

The YTD Plan Vs. Actual chart enables you to view your total IT planned costs versus actual costs for the
year-to-date. The chart can help answer these business questions:

l Is the program staying within the PoR?
l How much does the program have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest actual
cost. The chart can help answer this business question:

l Which top five suppliers are consuming the largest actual?
l What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-dis-
cretionary cost for the year-to-date. The chart can help answer this business question:

l What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart can help
answer these business questions:

l What is the allocation of the actual cost by category?
l Which top five categories account for the largest actual cost?
l What percent of the actual cost is for all other cost categories?

Example

This example shows the top 100 programs that have the highest planned cost. The first chart identifies
the planned and actual costs. The second chart displays the top five suppliers with the highest actual
cost. The third chart lists the total discretionary cost versus non-discretionary cost for a defined period.
The last chart identifies the cost by category.

The table below provides a description of the numbered items.
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Item Description

1 This filter sorts the top 100 programs with the highest planned costs.

a Programs are sorted by the highest planned costs. The colors preceding the
program identify the state of the plan:

Green indicates that the actual cost is within 100% of plan.
Yellow indicates that the actual cost is between 100 - 110% of plan.
Red indicates that the actual cost is over 110% of plan.

b The drop-down option determines the order of the list. The default is Program
by Plan.

Program by Plan lists the programs by the highest planned costs.
Program by Variance lists the programs by those that aremost over plan.
Program by Name lists the programs alphabetically.

2 TheYTD Plan Vs. Actual chart numerically displays the planned costs, actual costs,and the dif-
ference between them. The progress bar shows a negative difference between the planned and actual
costs in red. A vertical scale lists the percentage of planned versus actual.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a The vertical progress bar shows the actual cost.
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Item Description

b The costs for plan,
actual, and available
(difference between
the two) are listed in
thousands.

c The percent indi-
cates the actual
cost divided by the
plan cost multiplied
by 100.

3 TheYTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual cost
year-to-date.

a The legend identifies the suppliers.

b By placing themouse pointer over the pie chart, you can view the cost and per-
cent of total spending. The "Other" label in the pie chart displays the per-
centage of actual costs for all other suppliers who are not in the top five.

4 TheYTD Discretionary pie chart lists your total discretionary and non-discretionary costs for the
year-to-date.

a The legend identifies which section of the pie chart shows discretionary spend-
ing and which part shows non-discretionary spending.

b By placing themouse pointer over the pie chart, you can view the percentage
of discretionary costs and non-discretionary costs for the year-to-date.

5 TheYTD Actual Cost by Category pie chart displays the actual costs by cost category in thou-
sands.

a The legend identifies the cost category.

b By placing themouse pointer over the pie chart, you can view the allocation of
the actual cost by category and identify where the highest actual costs occur.
The "Other" label in the pie chart displays the percentage of actual costs for all
other cost categories.

Tier 2

The data in this tier enables you to view themonthly, quarterly, and yearly planned costs of the program
you selected in Tier 1.

TheMonthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month of the
fiscal year. You have the option to display the information quarterly. The chart can help answer these busi-
ness questions:
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l How well is the program staying within the plan on a monthly and quarterly basis?
l When did actual spending exceed the plan?

The Year-Over-Year Actual/Plan% chart provides historical monthly and quarterly data for the current
year and two previous years. The chart can help answer this business question:

l How well is the program staying within the plan based on historical spending of the plan?

Example

This example has two charts that interact with Tier 1. The first chart shows themonthly and quarterly
plan. The second chart provides historical spending based on the current year and previous two years.

The table below provides a description of the numbered items.

Item Description

1 ThePlan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal year. The
vertical bar indicates what was planned and the blue diamond indicates what was spent. You can
select the vertical bar to drill down into the organizations, business service, supplier, or cost category
details for that month or quarter in Tier 3. The selected bar is named in the chart's subtitle. In the pre-
vious example, the selected bar is FY09/03. It is darker than the other vertical bars. You can select the
View by Month or View by Quarter option to switch the display betweenmonths and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost amounts
for other periods, the chart may not display a gray bar for the period or periods with the lower planned
cost amounts.

a The highest amount on the vertical axis represents themaximum amount
planned or spent for amonth or quarter within the current year.
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Item Description

b The legend identifies the
costs:

Planned amount: Square
Actual amount spent:
 Diamond

2 TheYear-Over-Year Actual/Plan % provides details on what percent was actually spent compared to
what was planned over the last three years. The percentage is the amount spent divided by the amount
planned times 100. For example, if 120 was spent and 100 was planned, the percentage displayed will
be 120%. Note that no icon will appear on the chart if data does not exist for that period.

a The highest amount on the vertical axis represents themaximum per-
centage of the plan used for amonth or quarter period within the current
year and previous two years.

b The legend identifies the year of themonth or quarter:

Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected program for Organ-
izations, Business Service, Supplier, and Cost Category. The information can help answer these busi-
ness questions:

l Where is the program spending?
l Where does actual cost exceed the plan?
l What is the state of this program's organizations, business services, suppliers, and cost categories?

Example

This example shows the details for themonth or quarter selected in the Plan Vs. Actual chart from Tier 2.
The same information is displayed in a bar chart and in a table. The chart displays actual and plan costs
for an Unknown organization in January 2009. The table lists the actual and plan costs.
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The table below provides a description of the numbered items.

Item Description

1 The bar chart displays actual and plan costs for the selected program in four areas: Organizations,
Business Service, Supplier, and Cost Category. Each area is a separate tab.

a The horizontal bars display the actual and plan costs for the selected Organ-
izations, Business Service, Supplier, or Cost Category.

b The legend identifies the costs:

Actual costs: Blue
Plan costs: Gold

2 Using data from the selected Organizations, Business Service, Supplier, or Cost Category, the table
shows the details of plan versus actual for the selected program.

a The legend identifies the plan costs and the difference between actual and
plan.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

Note: Xcelsius does not display an alert icon when the planned cost for a
program, business service, supplier, or cost category is zero.

b The table lists the organizations, business services, suppliers, or cost cat-
egories.
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Tier Interaction

The interactive dashboard dynamically updates the charts when you choose a program, change the option
to view monthly or quarterly costs, drill down to get more details, or select the Organizations, Business
Service, Supplier, or Cost Category tab.

The table below provides a description of the numbered items.

Item Description

1 The drop-down option enables you to display all or a subset of programs.

2 By selecting a program from this list, all charts in Tier 1, Tier 2, and Tier 3 will change.

3 By selecting the View by Month or View by Quarter option, all Tier 2 and Tier 3 charts will change.

4 By drilling down from this bar chart, Tier 3 charts will change.

5 By selecting the Organizations, Business Service, Supplier, or Cost Category tab, the charts in Tier 3 will
change.
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Reports
You can use the out-of-box Web Intelligence (WebI) reports to view daily updates on actual versus
planned performance. You canmodify the analytics as necessary to support the specific cost analysis
needs of your organization. You can also perform ad hoc analysis of cost data to answer less common
questions, while knowing that the data you view is consistent across all users.

WithWebI reports, you can take advantage of these features:

Feature Description

Drill Down Drill lower in the hierarchy within the same analytic. For example, drill down from the
Year to examine data for a Quarter or drill down from theQuarter to examine data for a
Month.

Drill Up Drill higher in the hierarchy within the same analytic. For example, drill up from the
Month to examine data for a Quarter or drill up from theQuarter to examine data for a
Year.

Filter Specify the data that you want by using the Filter dialog. For example, filter on Retail
Customers for the Customer dimension. You can filter on a block (Chart/Table) or at the
report level.

Change Chart/Table
Type

Select the Chart/Table format you want, and then drag it onto the chart you want to mod-
ify. Web Intelligence transforms the chart/table on the report to the new chart/table type
you selected and re-allocates the data to different chart axes/ Table disposition, if nec-
essary.

Format Charts Right-click the chart and select Format > Chart. The Format Chart dialog box appears.
Select a tab (such as General or Appearance) and change the formats.

Duplicate a Chart Select the chart you want to duplicate. Click Duplicate on the Report toolbar, or click
the arrow next to theDuplicate button and then select where you want the duplicate
chart to be positioned in relation to the original chart. Web Intelligence inserts the dupli-
cate chart.

Add/Replace Object to
the Table

Select the object you want to add and drag it over to the table so that a red bar appears
where you want to place the object. Release the object.

For more information about usingWebI reports, see theSAP® BusinessObjects Enterprise InfoView
User's Guide and thePerforming OnReport Analysis withWeb IntelligenceGuide available at the SAP
Help Portal (http://help.sap.com) web site.

Data extracted from Project and Portfolio Management and Asset Manager populates this report:

l Multiple Dimensional Cost Comparison Analysis

To use reports

l From the main menu bar, click Reports and select the report.
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Multiple Dimensional Cost Comparison Analysis

Use theMultiple Dimensional Cost Comparison Analysis analytic to compare how the organ-
ization is doing by these dimensions:

l Customer
l Business Service
l IT Organization
l Location
l Suppliers

Each dimension has its own tab where you can view the cost variance amount, planned cost,
cost variance percentage, and actual cost.

The analytic can help answer business questions such as these:

l What are the top 10 dimensions with high cost variance amounts for the month or quarter?
l What are the top 10 dimensions with the highest planned cost for the month or quarter?
l What are the top 10 dimensions with high cost variance percentages for the month or
quarter?

l What are the top 10 dimensions with the highest actual cost for the month or quarter?

The table below lists details for Multiple Dimensional Cost Comparison Analysis:

Category Description

Usage Users CIO, IT Financial Manager, IT Finan-
cial Analyst, IT Manager

Frequency Monthly, quarterly, or yearly; the
default is quarterly

Layout
 details

Dimensions Customer, Business Service, Organ-
ization, Location, Supplier

Measures Cost Variance Amount, Cost Var-
iance Percentage, Planned Cost,
Actual Cost

Drill
 options

Drill down from a quarter to amonth

Drill up from a quarter to a fiscal year

Type Web Intelligence Report (WebI)

Format Bar chart and table

Universe IT Financial Analysis

Notes This analytic has five tabs: Customer, Business Service, Organization, Loca-
tion, Supplier. Each tab displays the data in a bar chart and a table measured
by four facts: Variance Amount, Planned Cost, Variance Percentage, and
Actual Cost.
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Admin
The data warehouse delivers different types of reports in a SAP BusinessObjects Enterprise XI 3.1Web
Intelligence format that report on administrative or Audit, Balance, and Control (ABC) activities. If you
have Administrator privileges, you can access the administrative or ABC reports from this menu. For infor-
mation about the reports, see theHP Financial Planning & Analysis DataWarehouse Administration
Guide.
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Tools
You can use business intelligence tools to access, analyze, report, and share information about your
organization. The BusinessObjects Information Portal enables you to view your inbox, favorites, and doc-
ument lists. For more information about using InfoView, see theSAP® BusinessObjects Enterprise Info-
View User's Guide available at the SAP Help Portal (http://help.sap.com) web site.

Information Portal

The Information Portal is a direct link to your installation of SAP® BusinessObjects Enterprise XI. SAP®
BusinessObjects Enterprise XI is a business intelligence application that enables you to view, edit, and
create analytics. You can:

l Add, maintain, store, and create database queries that generate analytics.
l Run queries at any time to refresh the data.

Note:Remember to enable popup windows from your browser when you access the Information Portal.
The link to SAP® BusinessObjects Enterprise XI automatically opens a new browser window.

How do I create aWeb Intelligence Report?

When you create aWeb Intelligence Report using the SAP® BusinessObjects Enterprise XI applications,
you can design and run queries. You can view and format the report, then save it for others in your organ-
ization.

Financial Planning & Analysis simplifies the query process with subject oriented views that contain uni-
verse objects. The universe that you choose has relevant dimensions, measures, and filters that are
essential for your particular interest.

For more information, refer to the SAP® Business Objects documentation available at the SAP Help Por-
tal (http://help.sap.com) web site.

How do I create an Xcelsius Flash report?

You can create Xcelsius Flash reports using the SAP® Business Objects Xcelsius application. Youmust
use the out-of-box Xcelsius report source files as templates when you create custom Xcelsius reports.
You can access the source files in the Xcelsius Source folder in the SAP® Business Objects InfoView
document list.

For more information, refer to the SAP® Business Objects documentation available at the SAP Help Por-
tal (http://help.sap.com) web site.

Use historical data in ad hoc queries

Financial Planning & Analysis enables you tomodify Web Intelligence Reports to use historical data
instead of current data for ad hoc queries. You can use a snapshot of the data from the time the records
were created tomake comparisons and do trend analysis. Tomodify aWeb Intelligence Report to use his-
torical data, edit the report query to include theShow Historical Information filter.

For more information, refer to the SAP® Business Objects documentation available at the SAP Help Por-
tal (http://help.sap.com) web site.
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Print

You can print the current page of the Financial Planning & Analysis application.

1. From the main menu, click Tools > Print.
2. Click the Print icon in the upper left corner.
3. In the Print dialog box, select the printer.
4. Click Print.
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